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Poll #1: About you - research role

- What is your role in research and/or quality
improvement?

= Research investigator

» Data manager/analyst

= Project coordinator

= Other — please describe via the Q&A function




Poll #2: About you - data experience

How many years of experience do you have working
with VA data?

= Less than 1
o 1-2

2 3-6

o 7+




RN

VA Information Resource Center (VIReC)

Mission
To advance VA capacity to use data effectively for
research and quality improvement and to foster

communication between research data users and
the VA healthcare community.
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What VIReC Does

- Develops knowledge about VA data
- Shares knowledge with VA researchers

o Intranet website

» VHA Data Portal (collaboration with NDS, VINCI
and Data Quality)

= Cyberseminars (hosted by CIDER/HSR&D)
= Guides, documentation, and tutorials
= HelpDesk (virec@va.gov)
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The Researcher's Guide to VA Data
VIReC \/A |nformation Resource Center

VIReC Home

Assisting VA
Researchers

» VIReC Resources £ ; : g VIReC provides guidance essential
) for helping VA researchers use
Support ‘ data and information systems.

About Us

» Research in the VA Learn more »

» VHA Links

£ search VIReC's Site

| | (o]

Assisting VA Researchers

VA Health Services Reseaxch & Development Service

Welcome to our Internet website.
I I : ;I :&D Looking for VIReC's resources for VA researchers? Visit our Intranet site. Learn more. ..

@ Who We Are News & Events Upcoming Seminars
o
& ﬂ&l’mati on VIReC is an HSR&D funded Open Positions at VIReC Oct 5: Overview of VA Data,
e for resource center. Qur mission is to VIReC is recruiting for two positions Information Systems, National
Veterans improve the quality of VA research in our Data Knowledge area: Databases and Research Uses

that utilizes databases and
information systems.

= Associate Director for Research Oct 14: What Can the HSR&D
« Sncial Science Analust Resource Centers Do For You?
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vaww.virec.research.va. OO0V (VA Intranet only)

INTRANET

Search All VA Web Pages WV
N TN

» Open Advanced Search

VA INFORMATION RESOURCE CENTER (VIReC)

VIReC Home

VA/CMS Home

About Us

New Users of VA Data
FAQs

Acronyms

HelpDesk

CONVERSATIONS ABOUT VA DATA

HSRData Listserv

CURRENT VA DATA NEWS

Data Issues Brief

L1}

GATEWAY TO DATA RESOURCES

VHA Data Portal

B

cess/Real-SSN-Request-Process.htm L

ALLLLL

{iF

Data News

ICD-10 Transition: VA will implement
the ICD-10 code set October 1,
2015. Datasets commonly used by
researchers will be affected.

More info...

New CMS Data for Researchers:
2013 Medicare, 2011-2012 MCBS,
and 2007-2012 HEDIS data.

More info...

NPCD Retirement Data Extended:

“Learn More!

Data Issues Brief, September 2015
Upcoming Cyberseminars

Real SSN Data Request Process

VA REDCap Project

Data Tip of the Month

(®) New from VIReC

Open Positions at VIReC

VIReC is recruiting for two positions
in our Data Knowledge area

m Associate Director for Research

m Social Science Analyst

ICD-10 Information for Researchers

i VIReC Resources

Working with VA Data: Guide to VA

Learn how the ICD-10 transition
affects select datasets commonly
used by the research community.

data sources, topics, and tools.

VA/CMS Data for Research Project:
Data custodian for CMS and USRDS
data for VA research.

Factbooks: Describe tables, columns,
and values in select CDW Domains.

Research User Guides: Detailed

imnfarmantinm An calask Aabks fAlirAas
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Database & Methods Series Objectives

- Introduce VA data sources and information systems

- Illustrate research and measurement approaches
using VA data sources

» Provide resources for data users
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Topics for Today

» Overview of VA data

- Highlights of most commonly used VA data sources
in Research and Quality Improvement (QI) projects

- Introduction to data processing platforms and EHR
(read-only) access portals

- Where to go for more help

10/2015
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Topics for Today

- Overview of VA data

- Highlights of most commonly used VA data sources
in Research and QI

- Introduction to data processing platforms and EHR
(read-only) access portals

- Where to go for more help
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Common Sources of VA and VHA Data

Clinical Care /
Patient Records
Data

Administrative /
Operations Data

Non-VA Data

Performance Veteran
Measurement Population
Data Surveys

Financial
Recordkeeping

10/2015
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Levels of Data

- Local facility data

« VISN level data

- Corporate (national) level
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Getting Oriented to VA Data

- A few resources that will help you get an overview of
VA data and how to use it...

VIReC

RESEARCHERS’ GUIDE TO VA DATA
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Toolkit for New Users of VA Data

VIReC

INTRANET

Search All VA Web Pages W

» Dpen Advanced Search

VA INnFORMATION REsouRce CENTER (VIReC)

VIReC Home

VA/CMS Home

Abourt Us

New Users of VA Data

FAQs

Acronyms

HelpDesk

VIReC

RESEARCHERS’ GUIDE TO VA DATA

Toolkit for New Users of VA Data

Overview

This toolkit is intended as a starting point for new users of VA data. It may also be useful to
experienced VA researchers who may be unaware of the many resources available within the
Vi,

Where to Start

There are many data sources available to VA researchers and it can be challenging to
understand the scope and contents for each data source. VIReC's "Introduction to VIReC and

VA Data” page contains a brief summary of the different VHA information systems.

There are multiple ways to search VIReC's website for resources and information. A starting
point for new researchers is to browse VIReC's available data sources and topics (i.e. Medical
SasS datasets and vital status ascertainment). Data source pages provide basic summary
information, a list of resources associated with the data source, and access information.

Understanding VistA

The Veterans Health Information Systems and Technology Architecture (Vistd) is the source
of data for many VHA datasets or databases of interest to researchers. Vistd is an integrated
system of software applications that directly supports patient care at Veterans Health
Administration (VHA) healthcare facilities.

New Users

o Introduction

o Toolkit

o Tutcrials

General Resources
# Data Access

Data Sources

Data Tools

E Data Topics

® Products & Services

# Special Projects
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The VHA Data Portal...

Data source
descriptions

Data access
Instructions

Tools &
platforms

Resources for
using data

/) VHA Data Portal

Welcome to the VHA Data Portal!

The one-stop-shop for data users’ needs.

The VHA Data Portal is a collaborative effort among the following
to provide a central gateway to information about VHA data:

- VHA National Data Systems (NDS)
- VA Information Resource Center (VIReC)

I -

Home Dafa Sources Data Access Tools Resources Training AboutUs Support

Data Sources Overview

ADUSH Enrollment File

AITC Mainframe
BIRLS Death File
CDW

- VA Informatics and Computing Infrastructuw

- VHA Data Quality Program

Qur missien is to promote a knowledge-sharing culture that suppol
VHA data users. The portal infegrates information from multiple

Medical SAS Inpatient &
Outpatient Data Sets

NPCD

OEF/OIF/OND Roster

commen format and single location to promote a comprehensive k

and to facilitate a positive end-user expenence.

CDW Review
On June 30, 2015, National Data Systems
released an email with an embedded
questionnaire to individuals identified who have
access to VHA's Corporate Data Warehouse
(CDW). The guestionnaire requested feedback
from users regarding his/her use of CDW, most
importantly inquiring if access is still needed in
the performance of a user's official duties.

Cyberseminars
Sept 29: Innovations in Healthcare Informatics:
Social Media and Behavioral Change
Oct 05: Overview of VA Data, Information
Systems, National Databases and Research
Uses
Oct 14: What Can the HSR&D Resource
Centers Do For You?

Popular Links

Data Access Request Tracker (DART)

_ . »
» DART Overview and Forms @&

= Launch DART Application &

NDS Operational Access Requests

= NDS Healthcare Operations Request Process
= CAPRI and VistAWeb Request Process
Resources

10/2015



= DATA.GOV

DATA CATALOG

Search Data.Gov

DATA  TOPICS - IMPACT APPLICATIONS DEVELOPERS CONTACT

organization:va-gowv

Datasets ordered by Populal

You are searching in the 1

Filter by location

| Enter location._.

n BN ORI
?. ;
LAMERICALSS

Map data CC-BY-54A by OpenStrest
Tiles by MapQuest

Topics

AAFPI (30)
Consumer (12)
Aging (3)
Education (2)

Topic Categories

Order by:

Popular

/ Organizations / Department of Veterans Affairs

Department of Veterans
Affairs

1 Publisher

Department of Veterans Affairs
Contact

Tom Garin

Share on Social Sites
Google+
Twitter

Facebook

National Survey of Veterans, Active Duty Service
Members, Demobilized National Guard and Reserve

Members, Family Members, and Surviving Spouses
Metadata Updated: May 21, 2015

The 2010 National Survey of Veterans (NSWV) is the sixth in a series of comprehensive nationwide surveys
designed to help the Department of Veterans Affairs (VA) plan its future programs and services for Veterans. It
also provides a snapshot profile of the Veteran population. Data collected through the NSV enables VA to:
follow changing trends in the Veteran population; compare characteristics of Veterans who use VA benefits
and services with those of Weterans who do not; study VAT ¥2s role in the delivery of all benefits and services
that WVeterans receive; and update information about Veterans to help the Department develop its policies.

Access & Use Information

Public: This dataset is intended for public access and use.
License: U S Government Work

Downloads & Resources

Web Page 30 views
MNVSSurveyFinalWeightedReport. pdf

0 Landing Page Visit page

Download

Dates

Metadata Created Date Nov 20, 2014
Metadata Updated Date May 21, 2015

10/2015
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Topics for Today

» Overview of VA data

- Highlights of most commonly used VA data
sources in Research and QI

- Introduction to data processing platforms and EHR
(read-only) access portals

- Where to go for more help
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VA Databases and Data Sources

VA Inpatient and .
Outpatient Data VA CMS Data for VA MCA National

(MedSAS) Research Clinical Data

. VA Corporate
VA Vl’lgE;{eStatus VA PIl)lggnacy Data Warehouse

Data

10/2015
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MedSAS Inpatient, Overview

Medical SAS® Inpatient
Care Setting and Datasets

Ay

. Acute Care: Main, Procedure, Bed
VHA Medical Centers e ) ? d
- Section, Surgery Datasets

(Local VistA system)

PTF data l Extended Care: Main, Procedure,

at AITC Bed Section, Surgery Datasets
monitored
by NDS Observation Care: Main,
- Procedure, Bed Section Datasets
Non-VA Care: Main, Procedure,
- Bed Section, Surgery Datasets
_

Patient Treatment File (PTF)
Austin Information Technology Center (AITC)
National Data Systems (NDS)

10/2015
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MedSAS Inpatient Data

- Data element examples
= Patient demographics
= ICD-9 diagnosis codes

= JCD-9 procedure/
surgery codes

- Data steward:
= National Data Systems (NDS)

« More information: MedSAS Research User Guide on
the VIReC Intranet

10/2015
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MedSAS Outpatient, Overview

Medical SAS® Outpatient Datasets/
Inpatient Encounters Dataset

: A Visit (SF) Dataset: The Visit Dataset
VHA Medical Centers e - report(s s<)ervices provided to a patient
(Local VistA system) in @ 24-hour period (see 2.4.1).
NPCD data Event (SE) Dataset: The Event
atAlTC - Dataset provides information about
monitored individual outpatient encounters (see
by NDS 242).
Inpatient Encounters (IE) Dataset:
The Inpatient Encounters Dataset
- provides information about
g / professional services received by
patients during an inpatient stay (see
243).

10/2015



s 22

MedSAS Outpatient Data

- Data element examples:
= Patient demographics

P -
\ \ 3

p ~ - Wy

= ICD-9 diagnosis codes

s CPT-4 procedure codes

- Data steward:
= National Data Systems (NDS)

« More information: MedSAS Research User Guide on
the VIReC Intranet

10/2015
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Impact of ICD-10* Transition on VA Data

- Affects diagnostic and procedural codes in patient
records and other new data

» Transition to ICD-10 in effect October 1, 2015
- Previously generated data will retain ICD-9 codes

- Projects using diagnosis and procedure codes in
projects spanning the compliance date will need to
use both ICD-9 and ICD-10 codes.

* International Classification of Diseases, 10th Revision /
10/2015



VA Databases and Data Sources

VA Inpatient and .
Outpatient Data VA CMS Data for VA MCA National

(MedSAS) Research Clinical Data

. VA Corporate
VA Vl’lgE;{eStatus VA PIl)lggnacy Data Warehouse

Data
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VA Managerial Cost Accounting System
National Data Extracts (MCA NDEs)

Department ¢
VHA Data

Portal

Home Data Sources Data Access Tools Resources Training About Us Support

Data Sources » MCA (formerly DSS) NDEs

MCA NDEs contain workload,
clinical, and financial data at
the patient level.

MCA NDEs

Overview
Content
Features
Access

Resources

List of

NDEs

VHA MCA (formerly DSS) National Data Extracts (NDEs)

#p Overview

VA’s Managerial Cost Accounting (MCA) System (formerly Decision Support System or DSS) contains fiscal data and clinical
information. MCA (formerly DSS) National Data Extracts (NDEs) data originates from various site-level MCA databases and
subsystems. NDEs are classified as Core, Clinical, Financial, or Program Activity.

MCA NDEs from fiscal year (FY) 2005 through the current year are now in the Corporate Data Warehouse (CDW) in SQL tables.
MCA NDE SAS data sets for all fiscal years were removed from the Austin Information Technology Center (AITC) Mainframe in
March 2013. These MCA NDE legacy SAS data sets for fiscal year (FY) 2000-2012 are available on requ =t

Note: Although DSS is now known as MCA, the SQL tables for the MCA NDEs within CDW are under a DSS Schema and still
use the DSS name (Example: Dss ALBCC). Supporting documentation on the CDW website also still uses the DSS name.

iz Content

NDEs provide workload, clinical, and fiscal data for each patient at the produc |, e 211 ter, sub-encouni » 0! de portment levels.
Hide MCA NDE names and descriptions.

CDWNDE Name Description
Table Pt
ALBCC Account Level Budgeter F.inancial reporting extract including data on labor hours and costs within each MCA
direct care department.
ALBHR Account Level Budgeter Hours | No longer active, combined with ALB NDE in FY09.
Admissions, discharges and beddays of care for each patient/attending physician
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VA MCA National Clinical Data

Y

- Data Element Examples:
= Date
= Test results
= Ordering provider
= Costs
- Data Steward:
» VHA Managerial Cost Accounting Office (MCAO)

« More information: Research User Guide: VHA

Decision Support System Clinical Data Extracts, 2nd
Edition (VIReC Intranet)
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VA MCA NDEs for Clinical Data

LAB

(1ab test &
costs)

LAR

(1ab test
results)

RAD

(radiology)

(pharmacy
prescriptions)
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VA Databases and Data Sources

VA Inpatient and
Outpatient Data

(MedSAS)

VA Vital Status
File

VA CMS Data for

Research

VA Pharmacy
Data

VA MCA National

Clinical Data

VA Corporate
Data Warehouse
Data
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VA Pharmacy Data

Medications dispensed from Three Sources
VA pharmacies

» VHA Managerial Cost
Accounting (MCA) NDE

= Pharmacy Benetfits
Management (PBM)

= CDW Bar Code
Medication
Administration (BCMA)
/Outpatient Pharmacy
Domains

10/2015
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VA Pharmacy Data

- Data element examples:

= Generic drug name, days supply, VA drug class, Cost
etc.

- Data Steward
= MCA PHA NDE: Managerial Cost Accounting Service
= PBM: Fran Cunningham
= CDW BCMA: National Data Systems

« More information: VIReC Research User Guide:
VHA Pharmacy Prescription Data, 2nd Edition

10/2015



VA Databases and Data Sources

VA Inpatient and .
Outpatient Data VA CMS Data for VA MCA National

(MedSAS) Research Clinical Data

. VA Corporate
VA Vl’lgE;{eStatus VA PIl)lggnacy Data Warehouse

Data
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VA Vital Status File

- Uses multiple sources of mortality information
» VA Workload Data
» BIRLS Death File
» Medicare Vital Status File
» SSA Death Master File

» Two files: Master and Mini

10/2015
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VA Vital Status File

- Data element examples:

= Date of death (variables from the different sources
and value selected as “best”)

o Last healthcare utilization date Faa
» Data Steward:
= National Data Systems

- More information: “Vital Status Overview” page
on VIReC Intranet

10/2015
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Corporate Data Warehouse (CDW

« Large, relational (SQL)
database organized into
data domains

« Data available from
1999 to present

TermCategory
2 TermCategonsderder

8= omerr

BcPsoEn Cateqontaerser
»CPTIEN varchars0) TermCategonSI0 () it
>staan smaiint TemCategary
>CPTCode chart) e

3 oimcrrcategoy ‘@l CPTName varchars0)

Varchar(8000) > Famiyancestors
® CPTCategon8iD ) Int

. c Qint - - J% TemSourcss10 Pl
PTCAtegoEN varchar(s0) varchar(100) > TemSource
¥ stain archar(100) > SystemarGrous

% CPTCatagory
> TypeorC ategory
e MajorCPTCategon 10 (K int
& MajorCPTCategory
2 BeginCPTRange
EnaCPTRange

¥ CategonySource varchar(s0) & AgeHigh

] chart)
| 1 FaeManF leNumber 811

sate
sate
varchar(50)
ehar(t)
smalint
smalint

© FeManFleNumber 81

© FieManFileName:  CPT

C———)

® FileManFheNumber. 75713
®FileManFieName.  SOURCE CATEGORY

O FieManFleName:  CPT CATEGORY

3 VPatientEdso (PK)
& VPatentEdIEN

ol oigint

3 VSHnTests0 (PK) bigint
VEKINTasUEN

¥ 8ta3n

% SkinTestsid (K int
1% EducationTopics0 10 % PatentsiD (1) " p
o e visisin (7% sgint "
e vistsi0 510 & EvriDateTune smasdatetime
> EvenDateTime e et varchar(sty
2 EventistaEnoDate varchar & EventD masdatetime
5 FumntistaTima Transformin heint Sitcad i 9 VProcadureDataTime Computed

RESEARCHERS’ GUIDE TO VA DATA

VIReC Factbook
Corporate Data Warehouse (CDW)
Inpatient 2.1 Domain (Part | — Inpatient)

Version 2
June, 2015

10/2015



CDW Origin

>150 VistA
Systems

& Content

Region 1
Data
Warehouse

CDW

Region 2
Data
Warehouse

Patient
Allergy

Inpatient
Outpatient
Inpatient Rx
Outpatient Rx
Lab Chemistry
Lab Microbiology
Vital Signs

Region 3
Data
Warehouse

Region 4
Data
Warehouse

Nightly updates to architected
database - no change to content



R,

Corporate Data Warehouse Data

« CDW Domain » Data Steward:

Examples
: = National Data Systems
o Patient
o Staff
. « For more
= Vital Signs : :
information:

= Allergies
o VIReC Intranet

= CDW SharePoint

= VINCI data
descriptions

= Inpatient

= Qutpatient

= Lab Chemistry

= Pharmacy Outpatient

10/2015
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VIReC Resources around CDW

1. CDW Structure and Content

] Domain Layout 3. Researcher’s Notebooks

Data Contents

Current Issues

. . # Notebook Author Released
Discrete Frequencies
4  How do I access SQL database files in VHAS  Fant, G 2015/03
Corporate Data Warehouse using SPSS? Gonsoulin, M
[+] Record & Null Counts
3 How do I identify the bed sections for my Ouellette, I 2015/03
inpatient cohort? Stolzmann, K
+
|:| Sampl = RECUI'['E 2 How do I identify a resistant organism in Evans, C 2014/11
CDW Lab Microbiology? Poggensee, L
Ramanathan, S
1 How do I identify the causative organism in Evans, C 2014/09
[
2. Domain Factbooks CDW Lab Microbiology? Poggensee, L

Ramanathan, S

=]l Facthbooks

This product provides descriptions of tables, columns, and values in select CDW [
induding domain-specific SQL "starter language” and sample SQL code.

Domain Released | & Fa%"““"s http://vaww.virec.research.va.gov
MNew! Patient Enrollment (with EWL) 1.0 2015/07 .

o tont ~—Taoi=r0s 5 /CDW/Documentation.htm

Mental Health 1.0| 2014/11 = (VA Intranet only)

Consult 2.1 2014/10 v
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VA Databases and Data Sources

VA Inpatient and
Outpatient Data VA CMS Data for

(MedSAS) Research

VA Vital Status VA Pharmacy
File Data

VA MCA National
Clinical Data

VA Corporate
Data Warehouse
Data
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VA/Center for Medicare and Medicaid
Services (CMS) Data

Medicare enrollment and claims data

Medicaid enrollment and claims data

Medicare Current Beneficiary Survey (MCBS)

Patient Assessment Data

United States Renal Data System (USRDS)

Medicare Advantage HEDIS

10/2015
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VA/Center for Medicare and Medicaid
Services (CMS) Data

- Data element - Data steward:
examples: - VIReC’s VA/CMS Data
= Medicare and Medicaid for Research Project

enrollment
= ICD-9 diagnosis codes - For more information
» ICD-9 and CPT4 > VIReC Intranet-
procedure codes VA/CMS Data for

= Charges and payments Research Home Page

10/2015
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Topics for Today

» Overview of VA data

- Highlights of most commonly used VA data sources
in Research and QI

- Introduction to data processing platforms
and EHR (read-only) access portals

- Where to go for more help
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VA Informatics and Computing
Infrastructure (VINCI)

- Secure data environment

- High-speed processing platform

- Free data management and analytic tools
- For more information: VINCI Central site

10/2015
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Austin Information Technology Center
Mainframe (AITC)

- Centralized computer processing center
 Available data
= MedSAS datasets

= VA Vital Status file

» For more information: VIReC Intranet or VHA Data
Portal

10/2015



EHR Data Portals - Compensation & Pension
Data Interchange (CAPRI) & VistAWeb

" CAPRI Both VistAWeb

Requires special
software and
access/verify codes

VA Intranet web

portal accessed
through local VistA

Read-only access to
EHR one patient at a
time

Data viewed from
one healthcare site
at a time

Data consolidated

Requi 1 SSN
equire rea from all sites in

single chronological
view

VistA Imaging
available

10/2015

Approval for one,
many, or all VA sites

Includes search
function

Direct access to
VistAWeb

Submit requests to
DART

/ll
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Topics for Today

» Overview of VA data

- Highlights of most commonly used VA data sources
in Research and QI

- Introduction to data processing platforms and EHR
(read-only) access portals

- Where to go for more help
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Where can | find information about
VA data sources?

VIReC VA Information Resource Center

HERC Health Economics Resource Center

AY TO DATA RESOURCES

GATEW,
VHA Data Portal

O~z VHA Data Portal

“-.hg'h'ﬂ 33
o
0t

Vl ,N\g VINCI Central

?ﬁ‘g

ig 44'0
o
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HSRData-L Listserv

» Join at VIReC’s Intranet Web site

- Exchange of current information, ideas, questions,
and answers about data and information systems
issues affecting VA research

- Discussion among > 1,000 VA-only researchers,
operations, data stewards, managers, and other
users

- Searchable archive of past discussions

10/2015
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Obtaining Help from VIReC

» VIReC Intranet site
= Research User Guides (RUGS)

- Variable-level information
= Technical Reports

= Web-site “Toolkit for New Users of VA Data”
» Monthly Data Issue Briefs
- HelpDesk
s virec@va.gov
o (708) 202-2413
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Take-aways

- VA has many data sources that are linkable

- Using big data requires informed and careful choices

i D. : : Il IIIII II" : ¥ ‘ :.D
v Yy . @
. N

- Use the resources VIReC and others offer to help
you navigate the data sources and to connect you
with peers, experts & additional info
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FY16 Database & Methods- Planned Topics

- Requesting Access to VA Data

- Assessing Inpatient and
Outpatient VA Health Care
Use

- Measuring Veterans’ Health
Services Use in VA and
Medicare

- Examining Veterans’
Pharmacy Data Use

- Assessing Race and Ethnicity

Measuring Laboratory Use and
Results

Applying Comorbidity
Measures Using VA and
Medicare Data

Improving Mortality
Ascertainment

Extracting Data from the EHR
Using CAPRI and VistAWeb

Using Data in the CDW
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Contact Information

Denise Hynes, PhD, MPH, RN
VA Information Resource Center
Hines VA Hospital
virec@va.gov

708-202-2413
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Questions?



Useful Links (VA Intranet Only)

- VIREC website
http://vaww.virec.research.va.gov/

- HERC website
http://vaww.herc.research.va.gov/

- VHA Data Portal
http://vaww.vhadataportal.med.va.gov/

« VINCI

http://vaww.vinci.med.va.gov/vincicentral/
- ICD-10 transition info

http://vaww.virec.research.va.gov/ICD-10/Overview.htm
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